GOPHER

Thank you for purchasing this product from Gopher.

2 2\ UNCONDITIONAL [fyou are not satisfied with any Gopher purchase for any
100% 100% SATISFACTION  reason at any time, contact us and we will replace the

N/ G UARANTEED product, credit your account, or refund the purchase price.

Read instructions in their entirety. In the event of missing parts, call 1-800-533-0446.

Limited Technology Product Warranty

Due to the sensitivity of technology products and circumstances beyond Gopher Sport’s control, Gopher Sport warrants to the original
purchaser that the FITstep™ Stream™ and HUB™ shall be free from defects in quality, materials, and workmanship under normal use
for a period of one year from the date of purchase.

The Limited Technology Product Warranty does not cover the replacement of batteries or problems arising from improper handling.
"

MacOS Software Manual

Operating System Requirements

Minimum Recommended
Operating System macOS 13 Ventura macOS 15 Sequoia
Processor Apple M1 or Intel Core i7 Apple M2 or Intel Core i9
Memory (RAM) 2GB 4GB
Storage Space 100 MB 500MB

Step 1: Installing FITstep™ Stream Software

Go to www.gophersport.com/software and select the ‘macOS FITstep™ Stream Software Download’ button to begin downloading the
latest version of FITstep™ Stream software for macOS.

IMPORTANT: Do NOT connect the Gopher HUB™ to your computer prior to launching and setting up the FITstep™ software. The
HUB™ will be connected once the application is set up correctly.

After the file is downloaded, double-click the file to automatically extract the Gopher FITstep™ v4.2 software application. Place the
application into your Applications directory by dragging and dropping the application icon into the Applications directory.

NOTE: All current FITstep™ data is converted to work with the latest version of FITstep™ software, and a backup file is created for
compatibility with older versions of FITstep™ software.

Step 2: Launch and Setup FITstep™ Stream Software

To launch the application, double click the application icon for FITstep™. Upon launch, the first thing you will need to do is set up a
database file to use with the FITstep™ software.

Database Files

To launch the application, double click the application icon for FITstep™. Upon launch, the first thing you will need to do is set up a
database file to use with the FITstep™ software.
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To create a new database file, follow these steps:

Create New Database File

1. Go to the application menu bar and select ‘File > New Database’ and enter a unique name for the database when the following
prompt is presented:

2. This new database file will have the name provided and the .db extension. The database file will be located in the root directory
of your Documents folder.

NOTE: If the FITstep™ application is being used by multiple users, each user should create a new database file for their needs.

Open Existing Database File

If this is NOT your first time using FITstep™ software, your current database file will be converted to work with the latest version of
the application.

To open a converted database file, or if multiple users have unique database files, follow these steps:
1. Go to the application menu bar and select ‘File > Open Database’ from the menu
2. A Finder window will open your Documents folder in order to select the database file you would like to use.

3. Select the database file you would like and click ‘Open’. This will load the selected database file and its data into FITstep™.

Step 3: Gopher FITstep™ HUB™ Setup

The HUB™ is required to transfer data from the FITstep™ Stream Pedometer to the FITstep™ software application.
To set up the HUB™, follow these steps:
1. Plug the HUB™ into your computer using the provided USB cable.

NOTE: If this is the first time connecting your HUB™ to your computer, you will be prompted by the operating system to allow
the accessory to connect as indicated in the following prompt. Please select ‘Allow’ to provide permission to connect the
HUB™ to your computer

2. The HUB™ will be automatically recognized by your computer and the setup process will begin automatically.

NOTE: The FITstep™ application will show an activity indicator during the setup process. You will know the HUB™ has been
set up correctly when the progress indicator stops and a status bar label, located under the FITstep™ logo in the lower left
hand corner of the application, labeled ‘Gopher HUBs: 0 has been updated to now indicate, ‘Gopher HUBs: 1', where ‘1’
indicates the number of HUBs you have connected to your computer successfully.
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IMPORTANT: Immediately after granting permission to connect your computer to the HUB™, you may be prompted again to update
the firmware on the HUB™. You will need to perform this update to continue using the application.

Update Gopher HUB™

You must update this Gopher HUB™ in order to use it with FITStep.
Press start to begin.

To begin the firmware update, select ‘Start’. You will be presented with a progress bar that will provide you with the current
percentage complete for the update. The update should complete within 90 seconds.

IMPORTANT: DO NOT disconnect the HUB™ from your computer while a firmware update is in progress!

After the firmware update is successful, a prompt will appear indicating the update succeeded and to disconnect the HUB™ in order to
finish the update. Disconnect the HUB™ and reconnect it to your computer to complete the firmware update.

If the firmware update fails for any reason, please disconnect the HUB™ and reconnect it to be prompted to perform the update once
again.
Settings Update

An update to the HUB settings may also be necessary before you are able to connect and communicate with pedometers. If this
update is needed, you will see the following two messages upon connecting the HUB to your computer.

NOTE: The update process will begin automatically when the first message is received without the user having to select ‘OK’ on the
message. Subsequently, this message will automatically be dismissed and the second message will be presented when the update is
complete. This second message will also automatically be dismissed should the user not select ‘OK’.

Step 4: Gopher FITstep™ Stream Pedometer Setup

Setting up a pedometer is a simple process, requiring the embedding of a number to identify the pedometer and check to see if there
is a firmware update available for the device.

IMPORTANT: The HUB™ must be connected and set up properly to continue with the pedometer set up. The pedometer may be in deep
sleep mode to conserve battery life. To wake the device, press and hold the yellow button entitled ‘Reset’ until the screen wakes up.
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IMPORTANT: The pedometer may be in deep sleep mode to conserve battery life. To wake the device, press and hold the yellow
button entitled ‘Reset’ until the screen wakes up.

To set up the pedometer, follow these steps:
1. Inthe FITstep™ application, select the tab entitled “Pedometer Setup” from the tab bar at the top of the app.

2. On the Pedometer Setup screen, locate the ‘Assign New Pedometer Number’ section and select the check box next to “\Write
New Number.”

3. Enter the desired number in the box next to the “Write New Number” label that you would like to embed into the
pedometer software.

4. On the pedometer you are setting up, press the blue button located on the front outside cover of the pedometer.
Then, place the pedometer direction on top of the HUB™ for it to connect.
Once connected, a firmware update may be required and the application will prompt you to start this update process. If you are
not prompted to update the firmware, you may proceed to embedding a number to identify the pedometer.
Firmware Update
If your pedometer requires a firmware update, a prompt will be presented to begin the firmware update after connecting to the HUB .

IMPORTANT: Ensure you selected the “Pedometer Setup” tab in the FITstep™ application in order to be prompted to update the
firmware if needed.

To perform a firmware update, follow these steps:
1. Select the ‘Start’ button to begin the firmware update process
2. A progress bar will appear and show progress for the update and indicate when it is complete.

IMPORTANT: This update should take approximately 35 seconds to complete. If the update should fail for any reason, the
pedometer will take approximately 10 seconds to attempt the update again.

If you are unable to update the firmware successfully, remove the pedometer from the HUB and set it aside while you set up the
remaining pedometers. After two minutes, you may attempt to update the firmware on the failed pedometer once again.

3. After the firmware update is complete, select ‘Done’ and remove the pedometer from the HUB.

Embedding a Number for the Pedometer

It is recommended to physically identify pedometers with numbers on both the outside and inside of each pedometer cover. This will
make it easier for students to identify the pedometer they are assigned each time they come to class.

IMPORTANT: The pedometer may be in deep sleep mode to conserve battery life. To wake the device, press and hold the yellow
button entitled ‘Reset’ until the screen wakes up.

To embed a number in the pedometer software, follow these steps:
1. Inthe FITstep™ application, select the tab entitled “Pedometer Setup” from the tab bar at the top of the app.

2. On the Pedometer Setup screen, locate the ‘Assign New Pedometer Number’ section and select the check box next to “Write
New Number”

3. Enter the desired number in the box next to the “Write New Number"” label that you would like to embed into the
pedometer software

On the pedometer you are setting up, press the blue button located on the front outside cover of the pedometer.
Then, place the pedometer directly on top of the Gopher HUB™ for it to connect.

The FITstep™ application will connect to the pedometer via the Gopher HUB™ and register the number entered. A message
will prompt you when the number has been successfully embedded in the pedometer.

7. Upon a successful numbering, the FITstep™ software will update the number input to the next sequential integer for your
convenience.

8. Grab the next pedometer you would like to set up and simply press the blue button located on the front outside cover and
place it on top of the Gopher HUB™.

9. Repeat this process until you have embedded a number for all pedometers

Checking a Pedometer’s Current Number

To check the current number embedded in a pedometer, follow these steps:
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1. Ensure the pedometer is on showing the current steps count on the screen. You can change the view being shown by
pressing the blue ‘Mode’ button inside the pedometer to the right of the screen.

Once you are on the ‘Steps’ screen, press and hold the red ‘Set’ button to the right of the screen.

3. The screen should update to show you the current number embedded in the pedometer. If you were embedding the number
1, the number will appear on the screen as follows: P - 00001.

NOTE: If the pedometer does not have a number embedded in it, pressing and holding the red ‘Set’ button will not change/
update the view on the screen.

Step 5: Class Setup

The Class Setup tab serves as the control center where you will add new instructors, grades, classes and students.

Manual Entry Class Setup

Teachers, students, and classes can be entered into the FITstep™ software manually by typing the information into each specific field.

Import Students into Class
The Import/Export menu offers the opportunity to import students into the FITstep™ software using a spreadsheet.
NOTE: Use Excel 2007 or higher (.xIsx) workbook.

The workbook should be set up as follows:

First Name Last Name Gender Pedometer Number Student Number

e Data cannot be imported unless a first and last name is provided.
e Pedometer numbers must be integers greater than zero.
¢ The software will accept gender identifiers of “Male”, “"M", “Boy”, or “B" for males.

[T

e The software will accept gender identifiers of “Female”, “F", “Girl”, or “G" for females.

e The student number field is available for adding student IDs or other unique identifiers. This field accepts characters and
numbers.

e Multiple classes can be stored in the same workbook, but each class must be in a separate worksheet.

Step 6: Uploading Pedometer Data into FITstep™

The FITstep™ application receives data from pedometers via the HUB™. The HUB™ connects to the pedometers using radio
frequencies, so it is important that the HUB™ and pedometers are in relatively close proximity to each other when attempting to
upload data.

IMPORTANT: To upload data from a pedometer, you must have the HUB™ plugged into your computer via a USB port and have your
Class set up correctly in the application. You will know the HUB™ is connected when an indicator, located under the FITstep™ logo in
the lower left hand corner of the application, labeled ‘Gopher HUBs: 0’ has been updated to now indicate, ‘Gopher HUBs: 1'.

To upload data from a pedometer to the FITstep™ software, follow these steps:
1. Launch the FITstep application and ensure your Gopher HUB™ is properly connected to your computer.
2. In the left panel, locate and select the Class for which you want to upload pedometer data
3. After selecting a Class, next select the tab entitled ‘Upload Pedometer Data’ from the tab bar at the top of the app.
4

Next, ensure students position themselves with their pedometers within approximately 10 feet from the Gopher HUB™ with
an unobstructed view to the HUB.

5. Once positioned, students press the blue button on the outside front cover of the pedometer and release it.

NOTE: For best results, have students open the cover of the pedometer before they press the blue button in order to view the
screen which will display a large arrow pointing up indicating the upload has begun.
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6. During data upload, you can observe the status of each student’s pedometer as you watch their names in the left panel.
Student names will re-sort automatically and will change colors to indicate the status of the pedometer upload. The following
indicates the associated color and status:

BLACK/GRAY: Pedometer is not connected to the HUB™

Ensure students pressed the blue button on the outside front cover of the pedometer and released it.
BLUE: Data upload in progress

RED: Data upload failed

This may occur if the pedometer loses connection to the HUB™ during data upload.

GREEN: Data upload successful

IMPORTANT: The critical part of the upload process is to leave the pedometer in the reader station until the red and green lights on
the reader stop flashing.

Any student that is present with their name remaining black/gray or red needs to remove the pedometer and attempt to upload data
again using the reader station. Make sure you have accommodated all students present before having them clear step data from their
pedometers.

Clearing Pedometer Step Data

Pedometers DO NOT automatically clear data once uploaded to prevent any loss of data should an error occur during the upload. As a
result, it is recommended to have students clear the pedometers at the beginning of every class.

IMPORTANT: Ensure that each student clears their pedometer prior to beginning the class activity.
To clear the data on a pedometer, follow these simple steps:

1. Open the cover and locate the yellow button labeled ‘Reset’ to the right of the screen.

2. Press and hold the yellow ‘Reset’ button.

3. The screen will flash a few times, and the number of steps taken should reset to zero.

To set up the pedometers to automatically clear after data offload, go to the Options Menu and Select “Clear Pedometer Data After
Readings.”

NOTE: If the pedometer is cleared and the data transfer fails, there is no way to restore the data.

Monitoring Data Upload in FITstep™

To ensure the FITstep™ application received data from all students during the upload process, you can reference the total number of
workouts that were recorded in the application by monitoring the status bar located at the bottom of the window, next to the HUB
connection indicator.

[ 1
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A label entitled “Workouts Recorded,” along with the current number of recorded workouts and the current number of students in the
class that are attempting to transfer their workout data, will appear in the bottom corner.

NOTE: After the uploading process is complete, if you select another class in the left panel and the current class upload process
resulted in unsuccessful data transfer, an alert will be presented indicating the unsuccessful uploads.

REPORTS
The Reports Tab is the data analysis center. Click on the Reports Tab to see different types of reports. All reports can be customized to
your preferences by sorting, filtering, and dragging and dropping.

e Sorting: The default order of sort is by name in ascending order. To sort any column in descending order, click on the title of
the column you want to sort and the order will be reversed. Click it again and it will return to ascending order. Sorting will move
entire rows, not just the column you clicked on.

e Date Range: You may choose the date range for all reports. Click on the Date Range indicator in the top right corner of the
Reports tab. The date may be entered manually, or by selecting the calendar button.

NOTE: It is not possible to select dates for the Class Roster Report.

e Columns: Select the columns you wish to show in your reports.

Report Details

Students can upload their data multiple times during the day. When the program calculates daily average for each student, it will add
together all uploads accumulated in a single day.

e \Workouts: Shows all uploads for each student. Every time a student uploads data, it is stored as a workout.

e Weekly Summary: Shows each student and their workouts by week. This allows you to analyze students and your lessons on a
week-by-week basis.

e Monthly Summary: Shows each student and their monthly totals and averages.

e C(Class Roster: Shows the full list of students by class. You can print several classes per print job by command-clicking on
selected classes.

e Physical Activity: Allows you to print a “My Physical Activity Report” for each student. The report contains a message to
parents and students along with the selected activity sheet (see below).

— Customize Activity Report command allows for customization of the physical activity report to suit your preferences.
Options that can be changed are:

= Edit Report Title

= Edit Intro Paragraph

= Change the School Logo

= Add Logo to Report
Print function is listed under the File menu. It is available when students have been selected, and the data is listed on the screen.
Report Viewer allows the report to be saved in different formats, including PDF or Word document.

Export to Excel is an option under the file menu. This allows any report chosen to be exported into an Excel spreadsheet.

Preferences Menu
The Preferences Menu allows the user to set some defaults for the software.

Select Start Date. This option is used for selecting a starting date for creating reports and screen analysis of data. This command
dictates what the starting date will be when the software is launched. It will always start at one of the options listed below until the
setting is changed. The following date range options may be selected:

e Today: Defaults to today.

e Yesterday: Defaults to yesterday.

e Current Week: Defaults to Sunday of the current week.

e Current Month: Defaults to the first day of the current month.
e Current Year: Defaults to January 1 of the current year.

e Last week: Defaults to Sunday of the previous week.
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e | ast Month: Defaults to the first day of the previous month.
e Fixed Start Date: Defaults to a fixed date that is selected.
e Custom Start Date: Allows data to be viewed from a certain number of days, weeks, months, or years.

— Select the time period (days, weeks, months, years) to go back, and then select the number of time periods you wish to go
back. When using this option, you will not necessarily go back to the start of the week, month, or year. When going back by
weeks, it will default to the same day of the week as today. WWhen going back months, it will default to the same day of the
month as today. Finally, when going back years, it will default to the same day of the current month in the previous year.

Show Advanced Data Options. This option can be used to check the amount of time students spent in each of the steps per minute
levels. The FITstep™ Pro Pedometers show how much time was spend at each SPM levels (80 to 160) steps per minute). By selecting
the advanced data option, this data can be reviewed.

NOTE: This feature only works when viewing the Workouts tab in Reports.

Customize Activity Reports. This option works on the Physical Activity report and can be used to customize reports. It allows changes
to be made to the Physical Activity report to suit the school preferences. The changes can be reviewed using the preview selection.

The options that can be changed are:
e Edit Report Title
e Edit Intro Paragraph
e Change the School Logo
e Add Logo to Report

Help Menu

The Help Menu provides easy access to the FITstep™ Software Instructions for reference during use. Additional information ca be
found by following the Gopher Sport Web Links.

Future updates to the FITstep™ Software will be available for download at www.gophersport.com/software
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